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Greetings to all.

Each month we try to select a theme
article and cover picture which we believe
to be of current general interest.  The “gen-
eral interest” part is often tricky and we
sometimes aim for large groupings.  But
nobody doesn’t use a hard drive these days
and we should all be aware of the value of
defragmenting those hungry critters.  As
they have become available over time in
greater capacities at lower prices, the ten-
dency is to keep feeding them data and let
them figure out where to stash it.  It’s what
they do and they do it very well.  Like any
reliable friend on whom you can rely for
faithful performance, they may go on with-
out complaint but with increasing strain.
And they are not immortal.  Give them a
break and yourself some rest.  Time was
when you could watch those charming data
placement charts jump their little vertical
lines around as they defrag the ten, twenty,
forty or so megabytes of precious info.  But
now it’s in gigabytes, less perceptible, and
boring.  So you may want to read the cover
article, set up the defrag, and do something
somewhere else.  You’ll both benefit.

The article described above and a large
share of our other material now come from
sources outside CCS since we get less lo-
cal material than some years ago.  The ma-

jor portion of our outside material comes
from our membership in the Association of
PC User Groups (APCUG).  Since it is a
group of organizations much like our own,
one might view it as an extended family with
similar experiences whose views and articles
bear strong relevance to our own interests.
Indeed, we share our own articles with
APCUG and one price of such success is
that we have a few of our own back in the
APCUG distribution, therefore a somewhat
smaller group of articles from which to
choose for our journal, lest we repeat our-
selves (sometimes a temptation to bestow
it twice).

The other main outside source is our free
access to the magazine content of Sandhills
Publishing, who produce Smart Computing,
PC Today, and eight other publications.
They provide a rich source of authoritative
material and we dip into it as we need or
feel appropriate.  So we are doubly blessed
with access to material outside our own.

This month our local sources have pro-
vided the usual internal material, like our
calendar of CCS meetings, CCS Board
meeting minutes, announcements, and no-
table member introductions, plus some book
reviews and a chapter report.  Additionally,
we have some photos from our Mini Expo
V, as a reminder of the coming sixth, MX-
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VI, in September, for which planning is well under way since it takes
about a year to set up each subsequent event of that scale.

Might I again request consideration by CCS potential authors of whether
they’d like to contribute an article on their PC-related experiences or
views, or a digital camera photo for our Share a Photo feature, or some
actual assistance to a heavily understaffed staff here.  If so, the next step
is sending your contact query to the e-mail address above.  �  (TOC)
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Paperback, published January 2007 by O’Reilly
Media;  $19.99.  CCS members receive a dis-

count if you follow the link in the Members Only
area on the CCS Website.

O’Reilly Media publishes at
least eight books in the Miss-
ing Manuals series which
Pogue created to fill the needs
of new software owners fac-
ing bare bones instructions
and the last resort Help fea-
ture within the program from
the original CD.

Because of the gravity of a whole new operating sys-
tem like Vista, or complex apps like Word, Access,
Powerpoint, or Excel, the series approaches each of these
subjects at two levels.  The concise, more elementary
but sufficient level is
termed “For Starters”.
This one is for those just
starting or novices with
a windows-based PC and
the new Vista operating
system.  If you have
some experience, this
helps you figure out the
new environment with-
out being too technical.
This is an inexpensive

BOOK REVIEW

Windows Vista for Start-
ers:

The Missing Manual

BY TIM KEKEIS

CCS MEMBER

Vista Alternatives –
Part II

This article is being writ-
ten  in the Linux ver-

sion of Open Office 2.0 on a
computer that uses Ubuntu as
the operating system (OS).
Since this sys-
tem is now net-
worked with my
Windows XP
c o m p u t e r s ,
both desktop
and laptop,  I
can easily transfer files between the computers.  I am
also able to print from this Linux computer to my laser
printer over the Windows network.  So what did I have
to do to accomplish this?

The first thing I had to do was to install a copy of
Samba on this Linux computer.  Ubuntu has an Add/
Remove graphic interface for the Synaptic Package
Manager.  This has a one-click download install for new
applications.  The Samba package that was installed had
a GsambaD graphic front end.  This turned out to be
very frustrating as it insisted I had to be logged in as
Root to run the application.  Now with most Linux ver-
sions this would be a simple change of user.  Root is
usually the designated Administrator and is the only user
allowed to alter system files and add/remove software.
There is also a user that has fewer privileges.  (Sounds
somewhat like Vista doesn’t it?) However, in Ubuntu,
the user is also the administrator.  To carry out any func-
tions that require administrator privilege, the OS asks

by Brian K. Lewis, Ph.D.
Sarasota PCUG, Florida
www.spcug.org
bwsail@yahoo.com

For More For More
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Mark your calendar for the upcoming
MX-VI Mini Expo Sept 15, 2007

At Prairie State College

MX-V
Revisited

Chicago  Computer Society Purpose

The Society is an education and information service  organization dedicated to expanding knowledge, understanding, and the use of

microcomputers by individuals and professionals.

        The purposes of  the Society are to operate exclusively for charitable, scientific or educational purposes, in the course of  which

operation and in furtherance thereof:

TO PROVIDE its membership with timely, accurate, and practical solutions to microcomputer productivity problems.

TO ATTRACT and help educate new microcomputer users, and to retain and learn from experienced, knowledgeable users.

TO SATISFY the information needs of  its membership.

TO BE a recognizable force in the industry so that Society opinions may positively influence future microcomputer products.
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Contact:
Beata Kernan - Administrator/Treasurer
708-588-0385 or ccsadmin@bigfoot.com

Share your knowledge

Is it possible
that you might find yourself able to help some of

our members in any computer related area of your choosing?

CCS Help Line

Have you ever wanted to print out what you see
 on your monitor screen? This is called a

“Screenshot,” and there are several software packages
on the market that allow you to do just that with various
degrees of sophistication. If you don’t need that
sophistication you can easily use Windows to get a
screenshot. Just follow these instructions:

1) Press the Print Screen Key (PrtScr) on the
keyboard.

2) Click Start, then click Run.
3) Type “mspaint” (without the quotes) in the Run

box and click OK.
4) In Paint, click Paste in the Edit menu.
5) Click Print Preview in the File menu. If the

screenshot is cut off, you may want to change the printer
setting to print in Landscape mode.

6) Click Print and close Paint. You’re done!

You can also save the file if you like.

1) Click “Save” in the File menu.
2) Browse to the folder you want to save the file in

so that the folder name is in the “Save In” box.

Screen Shots, or
How to catch Your Computer in the Act

By David Garcia, President,
Little Blue PC Club,
Northglenn, Colorado

3) Type a
file name for
the screenshot,
use JPG in the
“Save as Type”
box and click Save.

Article rights are reserved. This article may be
reproduced, downloaded, disseminated, or transferred,
for single use by nonprofit organizations for educational
purposes, with attribution to David Garcia, Little Blue
PC Club, Northglenn, CO. It should be unchanged and
this paragraph included. Please e-mail David Garcia at
littlebluepcclub@comcast.net when you use it, or for
permission to excerpt or condense.

There is no restriction against any non-profit group
using this article as long as it is kept in context with
proper credit given the author. The Editorial Committee
of the Association of Personal Computer User Groups
(APCUG), an international organization of which this
group is a member, brings this article to you.  �  (TOC)
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March, 2007

I, Robot?

Robots have come a long way
in the past 85 years o r

so.   The first “Robot” appeared in
a Capek play in 1920 as an artifi-
cial worker.  The word was derived
from the Czech  “robota,” meaning
labor.

In the 1940s
and ’50s
Asimov cre-
ated the intelli-
gent robot R.
D a n e e l
Olivaw, indis-
tinguishable in looks and behavior from humans.  Asimov
did not specifically equip his robots with computer brains
since computers were still thought of as fancy calcula-
tors and Artificial Intelligence had not yet been defined.
That happened during the 60s, and the computer HAL
9000 in Clarke/Kubrick’s 2001 Space Odyssey became
a famous example of a computer with an intelligent brain,
seemingly capable of using its own free will.

To this day artificial intelligence remains an unresolved
problem.  The question remains to what extent a com-
puter will ever be able to simulate the workings of a
biological brain.  Although they are sometimes called
electronic brains, computers have nothing in common
with biological brains.  Electronic computers are binary
digital, in that the basic elements can only be “on” or
“off.” A biological brain is analog and its basic elements

by Pim Borman, Webmaster
with notes by Kay Anne Peake
SW Indiana PC Users Group, Inc.
http://swipcug.apcug.org/
swipcug@sigecom.net

The New, the Best, and the
Worst

Actually, I was happy with my high-quality CRT
            (cathode ray tube) monitor.  It was with consid-
erable reluctance that I recently decided to get with the
modern era and upgrade to an LCD.  It has been quite a
learning experience.
Looking back, I real-
ize that there are a
number of very im-
portant practical con-
siderations of which I
was unaware in mak-
ing the change and in
making a choice.
Perhaps I can pass along a summary of them along with
some insight gained by hands-on experience to make the
experience a little easier for you than it was for me.  You
need to do your homework both before and during your
investigation.  Here are some of the most important things
you should know.

An LCD monitor offers considerable advantages in
upgrading from a CRT.  It is infinitely lighter and takes
up much less desk space than a CRT.  It uses the small-
est fraction of electricity by comparison and is devoid of
radiation concerns.  When properly installed, its display
may prove brighter, sharper and provide superb color.

SIZE:  In any size range, an LCD will display more
viewable screen than a similarly sized CRT.  I decided
on a 19 incher, the size of my CRT that I was happy
with.  Seventeen may work for you if that’s what pleased
you on your CRT.  Over 19 for average use is both too
much screen and excessive cost for most people.

ORIENTATION: Most prefer a normal tall screen
(portrait view) for average usage.  Wide (landscape)
screens are available at greater cost in the same size range

Upgrading to an LCD
Monitor

by Herb Goldstein
Software Eval. Chairman,
Reviews Editor
Sarasota PCUG, Florida
www.spcug.org
reviewseditor@spcug.org

For More For More
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When you connect your computer to the Internet,
you have opened a door which invites any other

computer in the world to come in.  Actually, you have
more than 65,000 doors into your computer, any one of
which may be open.  That is, unless
you have taken steps to keep these
doors closed.  That is the purpose
of a firewall.  The firewall filters the
information packets that show up
at your “door” or computer port as
we usually refer to it, and can ei-
ther prevent
them from enter-
ing or pass them
through.

When your
computer con-
nects to the Internet, it is assigned a numeric address or
IP (internet protocol) address.  These addresses are a 32
bit number.  They are   usually written out in four groups
with periods between each group as follows:
111.11.11.111.  Traveling over the Internet are many
programs that simply look for unprotected IP addresses.
The IP address of any unprotected computer is sent back
to the originator who can then upload a trojan or spyware
package to that address.  The originator can then take
control of  the computer or the application will record
keystrokes and send all recorded information back to
the program originator.

Although your computer has one IP address there are
many different ports on your address.  There are differ-
ent ports for different purposes on your computer.  Your
connection to the Internet is usually through port 80.
This is referred to as the HTTP (hypertext transfer tions

Why You Need A Firewall

by Brian K. Lewis, Ph.D.
Sarasota PCUG, Florida
www.spcug.org
bwsail@yahoo dot com

For More

SOFTWARE REVIEW

McAfee SiteAdvisor

by Sandy Berger,
 CompuKISS

www.compukiss.com
Sandy@compukiss.com

Anyone who has been on the Internet for a while
realizes that even websites that look benign can

generate viruses, adware, spyware, spam, and scams.
Until now, it was difficult to determine which websites
to avoid. Now, however, safe surf-
ing just got easier. Now there is a
wonderful free program that warns
you about dangerous websites.

The McAfee SiteAdvisor is a
small piece of software
that works with your
Internet Browser (either
Internet Explorer or
Firefox). It tells you in an
easy graphical format
which websites are safe
and which harbor spyware,
viruses, excessive pop-ups, or online scams.

McAfee has a system of automated spiders that pa-
trol the Web constantly checking out websites. They as-
sess the safety of each website including how much spam
is generated from signing up for information at that site
and how much spyware, adware, and other nasties might
be attached to downloads from that site. The SiteAdvisor
will also alert you to sites with excessive pop-ups and
those that are possible phishing sites. Besides the auto-
mated testing, McAfee has a team of individuals who
assess the sites. They use a detailed analysis as well as
feedback from individual users.

To use the SiteAdvisor, www.us.mcafee.com ,you sim-
ply download the free program.   The program is very
small, so it downloads and installs quickly and it doesn’t
slow down your Web surfing.

For More
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  It might surprise you to find that the data that ap-
pears to be so neatly organized inside files and folders
on your computer is actually more jumbled than a bucket
full of Scrabble letters.

While a computer’s hard drive is very precise in re-
membering where it has stored your data, it does tend to
store it in some strange places from time to time. Unlike
a neatly organized filing cabinet, your computer breaks
up large files into smaller file fragments tailored to fill
the first available free spaces on your hard drive.

This process of saving file fragments in the first avail-
able slot on your hard drive forces your computer to
work harder to read an entire file from start to finish.
Because the computer must work harder to read a par-
ticular file or program, it takes more time to complete
even a simple task, such as sending an email. Organizing
these scattered file fragments into contiguous segments
on your hard drive is called defragmenting.

Clean It Off: To Defrag Or Not To Defrag?

How & Why We Defragment Our Drives

by Thor Schrock

CCS Help Line

For Members Only.

You can get help with your computer needs by going to the
CCS web site in the members only area.

Click CCS Help Line.

 Reorganize Your Hard Drive

To better understand the concept of defragging a hard
drive, imagine picking up today’s newspaper and read-
ing a front-page article. After a few paragraphs, you are
asked to turn to another page to continue reading the
story.

    Diskeeper’s defragmentation software can
defragment files that the Windows Disk Defragmenter
cannot work with because they are in use.

It takes some time to open the paper, turn to the proper
page, and find the story to continue reading. Now, imag-
ine that you are required to move to a different page
after each paragraph of the story. It would take a lot
more time to read the fragmented story than it would
have if the story was printed on a single page.

For More



2007/04 www.ccs.org

Chicago Computer Society Hard-Copy

11

One of the downsides of a new Microsoft OS (op-
 erating system) is that system utilities fine-tuned

for previous editions of Windows don’t tend to work
well—or at all—with the latest OS.  Even small changes
in file systems, Registry settings, and other aspects of
Windows that utilities like to tweak can render the util-
ity useless, and then there are the programs that just plain
refuse to work with Vista at all.

Several of the top utility suites are now available in
Vista-compatible versions, but you really need to know
what you’re getting into before settling for one of them.
Some focus more on security than on utilities, others
that worked great under Windows XP aren’t fine-tuned
enough to be of great use in Vista, and then there are
those that are simply too powerful and dangerous for
Vista beginners to cut their teeth on.  It’s a bit like
Goldilocks and the three bears, but as long as you know
what type of porridge you prefer, we have some great
recommendations.

Iolo System Mechanic Professional 7
$69.95
www.iolo.com

   System Mechanic Professional 7 offers a variety of
security tools and system utilities in a single package.
Although the main System Mechanic 7 utility serves as
the core of the suite, you also get Iolo Antivirus, Iolo
Firewall, DriveScrubber 3, and Search & Recover 4 out
of the deal.

The system utilities worked well for the most part,
but there were some inconsistencies.  After the initial

An OS Unleashed
Comparing Vista-Com-
patible System Utilities

by Tracy Baker

For More

Downtown Computer
Club

by Allen Kapusta

Meeting of March 21, 2007

The meeting of the Downtown Computer Club was
called to order at approximately 6:00PM.  Joe

Vangsness moderated the open forum.

Thanks to National Louis University and Tracy
Dennard for providing the room for this meeting.

Open Forum

Q.  I installed Norton Utilities on my computer, but
uninstalled it because parts of it stopped working.  Now
I cannot re-install it.  I was trying to install it to use
Norton File Compare.

A.  Norton Utilities and Norton AntiVirus do not
uninstall cleanly.  Contact Symantec to get a program
that will remove them.  There are many file compare
programs available on the Internet.  Techtips.com is a
good source for computer help.

Q.  What should I use to backup my computer?
A.  Store your backup off-site.  The simplest choice is

to backup to CD or DVD.  Backup MyPC is a good
backup program.  Keep several copies of your backup
off-site.  Another solution for business continuity is to
backup to an Internet backup server and restore to a
laptop that has the software necessary to support your
business.

Q.  I had problems with my monitor. It displayed the
message “out of range”.  A friend fixed the monitor prob-
lem, but I wondered what the message meant.

For More
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  Apply for Membership   

Any way you look at it, your Chicago Computer Society membership is a great value!Membership
includes access to CCS monthly eHard-Copy journal, discounts on our Education Programs,
participation in our Special Events, and many other benefits.To join, print this page on your local
printer, then FILL IN THE BLANKS and MAIL it in along with your check made payable to The
Chicago Computer Society to ””The Chicago Computer Society”PO Box 159”LaGrange, IL 60525-
0159.  It will take approximately two weeks to process your appplication and six weeks to start
receiving your first issue of Hard-Copy, the Society’s award-winning monthly journal.Thanks for

your application and welcome aboard

Membership Application 

TYPE OF APPLICATION: (Non-Senior and Senior memberships include immediate family.) 
Check One: o Non–Senior o Senior (65+ with proof of age) o Student (Full time with copy of valid ID) 
Check One: o New o Renewal  PERSONAL INFORMATION: 
Last Name: ___________________________________ First Name: ______________________ Initial: ____ 
Street Address ___________________________________________________________________________ 
City: _____________________________________________ State: ________ Zip: ____________ 
Phone: Day: ______________________ Evening: _______________________  Email: _____________
 I o do o do not wish to occasionally receive vendors’ promotional material or e-mail solicitations. 
CCS Membership dues are $40 per year ($30 forSeniors [65+] or Students) 
MEMBERSHIP DUES ENCLOSED: _______________(Check or Money Order)  Make Check payable to:
THE CHICAGO COMPUTER SOCIETY 
Mail to: The Chicago Computer Society, P.O. Box 159, LaGrange, IL 60525-0159 

Please allow 2+ weeks to process this application and 6 weeks to receive your first Hard-Copy 

Where did you hear about CCS 

CCS Member: __________________________________________________ 
Other: _______________________________________________________    


